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At this Level 2 learners should be able to: 
 
“Use appropriate software to meet the requirements of a complex data-handling task”  
         Functional Skills Standards 2011 
 
 

 
 
If you have to deal with lots of numbers and calculations, a spreadsheet program can be very useful 
to save you lots of time and effort and keep a record of the numerical data. Using spreadsheets 
allows you to:  

 enter and edit text and numbers;  

 use formulae to do calculations; 

 alter the format of the figures;  

 produce appropriate charts and graphs based on the data; 

 analyse and draw conclusions from the data 

 

The most widely used spreadsheet program is probably Microsoft Excel. This is the program we 

used for the examples in this section. If you need to remind yourself of how to set up a spreadsheet 

and complete simple calculations using one, revisit Level 1 ForSkills ICT resources on spreadsheets. 

 

  

 

Learning 
Objectives 

“To be able to process and analyse numerical data” FS L2/7a 

 

“To be able to display numerical data in appropriate graphical 
format” 

FS L2/7b 

 

“To be able to use appropriate field names and data types to 
organise information” 

FS L2/7c 

 

“To be able to analyse and draw conclusions from a data set by 
searching, sorting and editing records” 

FS L2/7d 
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Glossary of Spreadsheet Symbols 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
  

= (always precedes the calculation) 
Calculate 

+ Add 

- Subtract 

* Multiply  

/ Divide  

Σ Sum  

# Error  

$ 
Absolute cell 
reference 
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Calculations  
 
All spreadsheets follow the mathematical rule of BODMAS. This is the order in which any 
mathematical calculations are made.  
 
This rule is ensures that any numbers in brackets are calculated first before division, multiplication, 
addition and finally subtraction calculations are made. 
 
Brackets  
Divide  
Multiply  
Add  
Subtract  
 
Example  
 
c7*(b7+b8) would add 10 and 18 and then multiply by £19.99  
 
c7*b7+b8 would multiply 10 by 19.99 and then add 18 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In this case, forgetting to use the brackets would have made nonsense of the whole procedure. You 
clearly wanted to find out the total sales value of sizes 10 and 12 – i.e. £559.72 - whereas, if you had 
forgotten to put in the brackets, you would have ended up with a total of 217.9 – and a meaningless 
calculation!  
 
 
 
  

 

Learning 
Objectives 

“To be able to process and analyse numerical data” FS L2/7a 
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Activity        Calculating Using Spreadsheets 
 

 Open a new spread sheet; 

 Use it to work out the following calculations; 

 Save it to your documents, titled Farm Park; 

 Print a copy of the completed spreadsheet for your tutor. 

 
Study the following data from The Black Sheep Farm Park and then use the spreadsheet to 
calculate: 
  

1. The total takings for each day; 

2. The total takings for the week; 

3. The percentage of weekly takings from concessionary tickets; 

4. The total sales from admission sales; 

5. The difference in sales between the most popular day and the least popular day. 

 

 

Day Adults Concessions Bags of Animal Feed 

Monday Closed 

Tuesday 98 109 30 

Wednesday 76 87 19 

Thursday 101 120 45 

Friday 87 103 21 

Saturday 209 404 100 

Sunday 199 240 69 

 

Adult tickets £9.75 

Children and OAPs £8.25 

Bag of animal feed £1.50 
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Copying and Pasting Formula 
 
This works in a very similar way to Microsoft Word; you are able to copy and paste cells in Excel. 
Very cleverly, when you copy a formula from one cell to another it will automatically adjust so that it 
reflects its new position. This is known as a relative reference.  
 
Example:  
Open the spreadsheet you constructed on the Black Sheep Farm Park. 
 
If all you were calculating was the number of purchases made each day, then you would use the 
formula =SUMd4+d5+d6 for Tuesday. If you copied that formula from d7 to e7 to find out the totals for 
Wednesday, the program will automatically add up all of the numbers in the cells e4, e5 and e6 
altering the formula to =SUMe4+e5+e6.  
 
However, what you need to do is use the same information from column b (i.e. the price) to multiply 
each day’s numbers in order to work out the takings for each category. 
 
i.e.  the numbers for the adult tickets all need to be multiplied by 9.75 (the value in b4); 

the numbers for the concessionary tickets all need to be multiplied by 8.25 (the value in b5); 
 the numbers for the animal feed all need to be multiplied by 1.5 (the value in b6); 
 
b4, b5, and b6 therefore need to be absolute cell references i.e. they need to remain constant each 
day. 
 
To create an absolute cell reference within a formula, add the $ sign to the cell reference. One $ sign 
in front of the column letter and another $ sign in front of the row number e.g. $B$1.  
 
So Tuesday’s takings were calculated by using this formula: 
 
=(d4*b4)+(d5*b5)+(d6*b6) 
 
However, to copy it to the other days we need to make the references in column  b absolute. This will 
make the formula look like this: 
 
=(d4*$b$4)+(d5*$b$5)+(d6*$b$6) 
 
 

 
 
 
Understanding this process will save you lots of time when faced with a task similar to this one. 
 
Open another sheet on your spreadsheet. Enter only Tuesday’s data initially and then try your 
new skill to calculate the figures for the rest of the week. Was it much quicker? 
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Making Adjustments to Spreadsheets 
 

1. Inserting rows and columns 
When you using spreadsheets on a regular basis to help organise your data, you may often 
need to add a row or column to keep your records up-to-date. 

 

Columns are always inserted to the left.    Rows are always inserted above. 
 

Examples 
It has been decided to start opening the Farm Park on Mondays, so to add a column to this 
spreadsheet, a column to the left of Tuesday will need to be added. To do this: 
 

 Highlight Column C by clicking in the heading bar; 

 Select the ‘Insert’ button; 

 Select ‘Insert Sheet Columns’ 
 
 

 
 
 
 
You will see that everything else has simply been ‘moved up’ a column – Tuesday has become 
Column D, Wednesday Column E etc 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
The Farm Park has also decided to add a new pricing category. This has been done by selecting the 
row below – in this case Animal feed – and then selecting ‘Insert’ and ‘Insert Sheet Rows’ 
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2. Formatting Text 
 
You will have noticed that the toolbar on Microsoft Excel is very similar to Microsoft Word and 
that means that changing the size, colour, style and format of the text you use on a 
spreadsheet created in this program is done in exactly the same way as in Microsoft Word.  
 
Style  Size Colour  
 
 
 
 
 
 
 
 
 

 
Formatting B = bold 

   I  = italic 
  U = underline 

 

Adjusting the font can be a useful way of highlighting important information and presenting your data 
in a more professional, attractive manner. 
 
Once you have formatted a particular cell using whichever of these tools is most appropriate to your 
task, you may copy the formatting to other cells by using the Format Painter. 
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3. Aligning Text 
 

Similarly you may align text within a cell in the same way you can align text within the cells of 
a table in Word. 
 
 
The orientation button will also rotate text. 
This can be very useful when you have limited  
room within a header cell. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Creating Borders and Shading 
 
To make your spreadsheets more attractive, it is also possible to add colour or border lines to 
the headers or to specific cells. 
 
Highlight the row you wish to add colour to, in this case row 3, and choose the appropriate 
colour from the font icon. Similarly, add colour to your chosen column – in this case column F 
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To add appropriate borders, select the specific area you wish to add borders to, followed by 
the appropriate borders from the drop down list on Borders in the ‘Font’ section 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Formatting Numbers 
 

When initially entering values into cells on a spreadsheet, they will appear as plain digits. 
However, to facilitate ease of understanding and interpretation you may need to format the 
numerical information entered. 
 
Examples: currency, date, time, percentages, fractions etc. 
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Activity         Formatting Numbers 
 
Investigate how you can change currency, or enter times and dates by: 
 

 Opening a new sheet 

 Enter the data from the table below; 

 Select ‘Format’ and then ‘Format Cells’ to see a window from which you select the Number 

tab; 

 

 

 

 

 

 

 

 

 

 

 

 Use to the currency button to change the numbers to currency; 

 Use to the date button to change the numbers to dates; 

 Use to the time button to change the numbers to hours. 

 

Enter the following numerical data onto a spreadsheet, format the numbers appropriately and 
work out the wages due to each person for each week. 
 

Name  
Rate per 

hour 

W/E 13.01.12 W/E 20.01.12 W/E 27.01.12 W/E 03.02.12 

No of 
hours 

Pay No of 
hours 

Pay No of 
hours 

Pay No of 
hours 

Pay 

S. Brown 6.95 6.5  8.25  10  9  

P. Black 6.95 12.5  13.75  14  14  

F. Smith 7.20 30  35  32  33  

H Thomson 9.20 36  36  36  36  

S.Legg 10.20 38.5  38.5  36  40  

 
Save the sheet in ‘My Documents’ titled Monthly Wages. 
 
Print a copy for your tutor. 

You may need to 
adjust or choose 
appropriate options 

This is a 
description of 
what the 
function will do 
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Displaying and Printing Formulae 
 
If you enter a formula into a cell, the result will be displayed within that cell. However, sometimes it 
may be useful to see the formula rather than the result e.g. when checking for errors. 
 
To do this: 

 Select ‘Formulas’ tab; 

 Select ‘Show Formulas’. 

or 

 Press <Ctrl`>. 

To print: 

 Select ‘Page Layout’ tab; 

 Select ‘Print’ from ‘Sheet Options’ section; 

 Return to main view using shortcut <Ctrl`>. 

 

Inserting Functions 

Functions are time-saving shortcuts which are available in Excel which create formulae to calculate 

specific common calculations. 

 

 Select ‘Formulas’ tab; 

 Select ‘Insert Function’; 

 Select an appropriate function from the drop down list or type in the function you need; 

 A description of what each function is used for will appear as you select the function 

 
Example 
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Common Functions 
 
Average function  
 
The AVERAGE function finds the average of the numbers in a cell range.  
 
Example 
It can be typed directly into the cell. For example: =AVERAGE(D7:I7)  

 
Select the tick or press the Enter key on the keyboard to accept the formula.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
or 

 Select the Formulas tab; 

 Select ‘Insert Function’; (f x) 

 Select AVERAGE from the drop down list; 

 Select the OK button; 

 When the Function Arguments dialogue box appears, check that the correct cell range is 
showing in the Number 1 box. If not, type in the cell range you want to use. 
 

 Click on the OK button and the AVERAGE function will be inserted into the cell. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
MAX function 
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The MAX function finds the maximum or largest number in a specific cell range. 
 
Example 

 
It can be typed directly into the cell. For example =MAX(D4:I4) – this will tell me the largest number of 
adult tickets sold. As before, you will need to tick the formula as accepted or select Enter before it will 
give you the answer. 
 

or 
 

 Select Insert Function, as before 

 Select MAX and then OK 
 

 

 
 
 

 Insert the correct range of cells  
 
 
 
 
 
 
 
 
 

 Select OK 
 

 
 
Answer also shows here 
Other Common Functions 
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MIN function 
 
The MIN function finds the minimum value or smallest numbers in a cell range. 
 
This function works in a very similar way to MAX and AVERAGE. 
 
The formula is =MIN(A1:A10) or whatever the relevant cell range is. 
 
 
 
 
COUNT function 
 
The COUNT function counts the number of cells that contain numbers in a specific cell range. 
 
This function works in a very similar way to MAX and AVERAGE. 
 
The formula is =COUNT(A1:A10) or whatever the relevant cell range is. 
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Activity        Using Formulae and Functions  
 

 Open a new spreadsheet in Excel; 

 Enter the following information about a sales company’s monthly expenses; 

 

 

 Work out the following calculations; 
 

1. What are the total expenses for each branch? 

2. What is the total for the company? 

3. How many employees are there in each branch/for the whole company? 

4. What is the average cost of motoring expenses over the whole company/ 

5. Which branch has the lowest average of expenses per head not counting wages? 

 

 Save the spreadsheet; 

 Print the spreadsheet for your tutor. 

Branch Name Wages  
Motoring 
Expenses 

Mobile 
Charges 

Subsistence 
Expenses 

Exeter 

B. Babcock £1 500 £400 £35 £200 

C. Ahmed £1 500 £80 £35 £47 

K. Rowan £1 500 £80 £35 £33 

S. Scott £1 500 £100 £35 - 

J. Harper £1 500 £1 000 £35 £400 

G. Platt £1 500 £76 £35 - 

Bournemouth 

G. Lee £1 500 £36 £35 - 

S. Hainey £1 500 £550 £35 - 

J.Thompson £1 500 £360 £35 £200 

P. West £1 500 £76 £35 £47 

N. Storey £1 500 £68 £35 £33 

M. Smith £1 500 £80 £35 - 

Reading 

L. Linacre £1 500 £96 £35 - 

R. Brown £1 500 £674 £35 £320 

D. Davies £1 500 £467 £35 - 

Y. Bray £1 500 £66 £35 - 

M. Hayes £1 500 £367 £35 -- 

S.Rzepinski £1 500 £367 £35 - 

Derby 

T. Statham £1 500 £367 £35 - 

M. Homer £1 500 £298 £35 - 

P. Hadley £1 500 £490 £35 £50 

M. Parker £1 500 £640 £35 £200 

N. Hamer £1 500 £464 £35 £47 

Peterborough 

F. Tingle £1 500 £45 £35 £33 

S. Owen £1 500 £457 £35 - 

L. Boddy £1 500 £34 £35 - 

S. Soni £1 500 £332 £35 - 

Stamford 

P. Jani £1 500 £280 £35 - 

P.Parker £1 500 £65 £35 - 

S. Legg  £1 500 £555 £35 £46 
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Numerical information is sometimes more usefully presented using charts and graphs to aid ease of 
reading. You must decide whether the information you are presenting is most appropriately and 
efficiently presented using a pie chart, bar chart, single line graph, scatter graph etc. 
 

Once you have made that decision, your data can easily be converted into appropriate graphical 
format using Excel. 
 

Select the ‘Insert’ tab and then the ‘Charts’ section. 

 

 

 
You will then be faced with several choices: Column, Line, Pie, Bar, Area, Scatter, Doughnut etc. 
Within these choices there are also several design options. 
 
Example 
 
If you wanted to see how the total takings could be displayed in a column chart, you need to highlight 
the Total Takings row, and then select Column. You will then be faced with several different design 
options. Whichever kind of chart you select, you will be faced with several different design options. 
Simply select the one you wish to use. Experiment with several to see which is most appropriate for 
the task. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now try the activity on the next screen. 

 

Learning 
Objective 

“To be able to display numerical data in appropriate graphical 
format” 

FS L2/7b 
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Activity      Displaying Numerical Data in Graphical Format 
 

 Open the spreadsheet ‘Farm Park’ that you created earlier and saved; 

 Investigate how Excel displays this information in chart format using all the different options; 

 Note how Excel will automatically use any details from the original text to create legends 
and/or titles for the various charts; 
 

 Simply by selecting a different option from the choice of charts, Excel will convert the chart and 
the data into a different graphic; 
 

 Decide which option you think displays this data most efficiently and effectively; 

 You may reposition elements within a chart manually by dragging and dropping – experiment 
with this option; 
 

 You may adjust the colours and graphic designs if you wish; 

 Check the axis titles, legends and data labels. Do you wish to alter or amend them? You may 
add, edit or remove any of these labels by following the on screen instructions; 
 

 Now select the ‘Move Chart’ button on the ‘Design’ tab and move the chart to Sheet 2 on your 
spreadsheet; 

 

 Save your work; 

 Print Sheet 2 for your tutor. 

 

You may copy and paste this chart into other applications like ‘Word’ or ‘PowerPoint’. 
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It is essential, when creating either data bases or spreadsheets, to ensure that field names are given 

meaningful titles. Be specific in your labelling. So, for example, if you look back at the last task on 

Page 16, where you were given information in a table, you will notice that the table has titles which 

label each column and each row (the text in coloured cells). 

 

When you converted this table to a spreadsheet, you would need to make sure the cells in your 

spreadsheet also contained these field names in order for the data to actually mean anything tangible. 

Just labelling them A, B, C, D and the areas Area 1, 2 etc would not be meaningful and make 

nonsense of the whole data. 

 
 
 

 
  

Learning 
Objective 

“To be able to use appropriate field names and data types to organise 
information” 

FS L2/7c 

Branch Name Wages  
Motoring 
Expenses 

Mobile 
Charges 

Subsistence 
Expenses 

Exeter 

B. Babcock £1 500 £400 £35 £200 

C. Ahmed £1 500 £80 £35 £47 

K. Rowan £1 500 £80 £35 £33 

S. Scott £1 500 £100 £35 - 

J. Harper £1 500 £1 000 £35 £400 

G. Platt £1 500 £76 £35 - 

Bournemouth 

G. Lee £1 500 £36 £35 - 

S. Hainey £1 500 £550 £35 - 

J.Thompson £1 500 £360 £35 £200 

P. West £1 500 £76 £35 £47 

N. Storey £1 500 £68 £35 £33 

M. Smith £1 500 £80 £35 - 
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Similarly, ensure that you specify the data type for each row or column by formatting them from the 
General section on the Home tab and then choosing the appropriate data type. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
By doing this, the program will prevent you making simple errors like adding the wrong columns. For 
example, here, where the learner had meant to add currency amounts in column D and E but had 
erroneously typed in C and D, the program produced an error message since a date (in column C) 
cannot be added to an amount of money (in column D). 
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